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RESUMO 

O presente trabalho apresenta um tutorial do SAP 2000 v.16 - Structural Analisys 

Program, para modelagem, dimensionamento e análise estrutural de um galpão com 

estrutura em perfis metálicos. O SAP 2000 é um software para análise estrutural que 

utiliza o método dos elementos finitos, desenvolvido pela empresa americana CSI – 

Computers&Structures Inc. e comercializado no Brasil pela empresa Multiplus 

Softwares Técnicos in. O software é vastamente utilizado para analisar edificações 

de pequeno, médio e grande porte, no entanto, apesar de ser uma importante 

ferramenta de análise e dimensionamento, nota-se a dificuldade dos alunos de 

engenharia civil em aprender a usá-lo, assim como a escassez de material em 

português apresentando, didaticamente, tutoriais para auxiliar na utilização do 

programa, visto que, com a evolução das estruturas, que estão se tornando cada vez 

mais complexas, tornou-se, em grande parte das situações, inviável a resolução por 

meio de cálculos analíticos. Desta forma, o presente trabalho visa contribuir para 

diminuir estas dificuldades, apresentando um manual de modelagem, 

dimensionamento e análise de uma estrutura metálica, a fim de gerar o perfil 

adequado para cada barra, assim como os diagramas de esforços, deflexões, 

momentos, cisalhamento, reações e deformadas.  

 
Palavras-chave: SAP 2000, análise estrutural, dimensionamento estrutural, 

modelagem, esforços, carregamento, tutorial, estrutura metálica.  
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ABSTRACT 

The present study presents a tutorial of the SAP 2000 structural analysis program for 

modeling, dimensioning and structural analysis of a building with structure in metallic 

profiles. SAP 2000 is software for structural analysis that uses the finite element 

method, developed by the American company CSI - Computer & structures Inc. and 

marketed in Brazil by the company Múltiplos Softwares Técnicos in. The software is 

widely used to analyze small, medium and large buildings, however, despite being an 

important analysis and dimensioning tool, it is noted the difficulty of civil engineering 

students in learning to use it, as well as the shortage of material in Portuguese 

didactically presenting tutorials to assist in the use of the program, since, as 

structures evolve, becoming more and more complex, in most situations, resolution 

by means of calculations analytical. In this way, the present work aims to contribute 

to reduce these difficulties, presenting a manual of modeling, dimensioning and 

analysis of metallic structure, in order to generate the adequate profile for each bar, 

as well as the diagrams of efforts, deflections, shear, reactions and deformed 

Keyword: SAP 2000, Structural analysis, structural design, Modeling, efforts, loading, 

tutorial, metallic structures. 
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1. INTRODUÇÃO 

O transporte e armazenamento de produtos de forma adequada é imprescindível 

para a indústria, desta forma, o uso de galpões se faz extremamente necessário. 

Existe uma vasta opção de estruturas de galpões, como, por exemplo, galpão em 

arco, galpão em shed, galpão de lona piramidal e galpão metálico. Cada tipo possui 

vantagens e desvantagens, adequando-se ao objetivo desejado. 

Os galpões metálicos possuem inúmeras vantagens, dentre elas, a racionalização 

dos materiais, evitando o desperdício e, consequentemente, economizando recursos 

materiais e financeiros, além de proporcionar maior agilidade na construção pois 

tratam-se de estruturas pré-moldadas. Outra vantagem é a maior limpeza e 

flexibilidade durante a montagem das peças pois não há uso de argamassas, o que 

evita a geração de entulhos, sendo benéfico, também, para o meio ambiente. Além 

disto, as estruturas metálicas são mais leves o que reduz os custos com a fundação. 

O programa SAP 2000, Structural Analysis Program, permite a modelagem, análise 

e dimensionamento estrutural, utilizando o processo de subdivisão da estrutura em 

elementos finitos, para realização dos cálculos. Por sua versatilidade, permite 

utilização para dimensionamento das mais diversas estruturas, como pontes, 

barragens, edifícios e qualquer infraestrutura necessária, conforme Morais. 

O presente trabalho trata-se de um tutorial para modelagem e análise de um galpão 

metálico no software SAP 2000 v.16, e tem por objetivo auxiliar alunos, engenheiros, 

arquitetos e os demais profissionais interessados em fazer uso deste programa. 
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2. REVISÃO BIBLIOGRÁFICA 

2.1 PROPRIEDADES DO AÇO ESTRUTURAL 

O conceito de metal está intimamente relacionado a determinadas propriedades, 

facilmente, reconhecíveis, entre outras, o brilho metálico, opacidade, boa 

condutibilidade elétrica e térmica, e ductilidade, de acordo com Pannoni (2001). O 

dimensionamento do perfil da estrutura é determinado a partir da escolha do aço, 

para isso, segundo Santana (2018), é primordial conhecer o diagrama Tensão x 

Deformação, apresentado na Figura 1, cujo objetivo é ilustrar o comportamento de 

aço dúctil em corpos de prova submetidos ao esforço normal de tração. 

Figura 1: Diagrama Tensão x Deformação 

 

Fonte: (Pinheiro, 2005 apud Santana, 2018, p. 20) 

Tem-se que: 

f – Tensão do material; 

fu – Tensão última; 

fy – Tensão de escoamento; 
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fp – Tensão de proporcionalidade; 

Ɛ – Deformação específica; 

Ɛu – Deformação específica na ocorrência da última tensão; 

Ɛy – Deformação específica limite quando ocorre a tensão de escoamento; 

Ɛp – Deformação específica quando ocorre a tensão de plastificação; 

α – Ângulo de inclinação da reta da região elástica. 

Segundo o diagrama Tensão x Deformação, o aço, ao ser submetido a determinada 

tensão, sofre uma deformação respectiva à tensão aplicada. A primeira região do 

diagrama é a região elástica, na qual, o comportamento do aço é mais dúctil, ou 

seja, a deformação sofrida não é permanente, após a retirada da tensão, o aço 

retorna ao seu comprimento original. 

No entanto, a partir de uma determinada tensão, chamada, tensão de escoamento, 

parte da deformação sofrida se torna permanente, nessa fase, o aço entra na região 

elastoplástica, não retornando mais ao comprimento original após a retirada da 

tensão aplicada. Após essa fase, a tensão última é a tensão na qual ocorre a ruptura 

do aço, devendo ser terminantemente evitada, para preservar a segurança da 

estrutura metálica. Por esse motivo, é de suma importância conhecer o diagrama do 

aço que será utilizado na estrutura a fim de torná-la o mais segura possível. 

2.2 PROPRIEDADES MECÂNICAS DO AÇO ESTRUTURAL 

Existem inúmeros fatores que afetam as propriedades mecânicas do aço estrutural, 

conforme Pannoni (2001), os principais são a composição química, o histórico 

termomecânico do material, a geometria, temperatura, estado de tensões e a 

velocidade de deformação da estrutura. Dentre esses, o mais importante na 

determinação das propriedades de um certo tipo de aço é a composição química, 

por exemplo, nos aços carbono comuns, os elementos Carbono e Manganês 

influenciam no controle da resistência, ductilidade e soldabilidade. 
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Ainda segundo Pannoni (2001) a maioria dos aços carbono estruturais tem mais de 

98% de Ferro, de 0,2 a 1% de Carbono e, aproximadamente, 1% de Manganês. No 

caso do Carbono, por exemplo, aumenta-se a dureza e a resistência, entretanto, a 

ductilidade e a soldabilidade são afetadas. Dessa forma, é importante combinar 

diversos elementos a fim de obter uma liga de aço com o máximo de propriedades 

para a situação em que será aplicado.  

Na tabela 1 é possível observar como cada elemento influencia nas propriedades 

mecânicas do aço estrutural. 

Tabela 1: Influência dos elementos nas propriedades mecânicas do aço estrutural 

 

Fonte: (Pannoni, 2001, p. 4) 

De acordo com Pfeil e Pfeil (2009) apud Santana (2018), as resistências à ruptura de 

aços estruturais são semelhantes, variando de 300 MPA até limites superiores a 

1200 MPa. Ainda segundo Pfeil e Pfeil (2009) apud Santana (2018), algumas das 

principais propriedades do aço são ductilidade, fragilidade, resiliência, tenacidade, 

dureza, fadiga, corrosão e efeito de temperatura. 

A fim de padronizar os cálculos dos projetistas no dimensionamento, a ABNT NBR 

8800:2008 estabelece os seguintes valores para as propriedades mecânicas dos 

aços: 

a) Módulo de elasticidade, E = Ea = 200 000 MPa; 

b) Coeficiente de Poisson Va = 0,3; 

c) Modulo de elasticidade transversal, G = 77 000 MPa; 
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d) Coeficiente de dilatação térmica, βa = 1,2 x 10-5 °C-1; 

e) Massa específica, ρ = 7 850 Kg/m³ 

2.3 PROPRIEDADES GEOMÉTRICAS DO AÇO ESTRUTURAL 

A fim de padronizar e organizar a produção e os projetos de estruturas metálicas, 

convencionou-se perfis cujos fabricantes estabelecem valores pré-fixados para altura 

e espessura da alma, comprimento da mesa, etc. As peças podem ter origem 

siderúrgica e metalúrgica. Conforme Pinheiro (2005), as peças siderúrgicas são 

classificadas em perfis, barras e chapas, como é mostrado na Figura 2. 

Figura 2: Peças siderúrgicas 

 

Fonte: (Pinheiro, 2005, p.2) 

Enquanto a indústria metalúrgica produz perfis compostos por chapas dobradas e 

soldadas, conforme a Figura 3. 
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Figura 3: Peças metalúrgicas 

 

Fonte: (Pinheiro, 2005, p. 2) 

2.4 ESTADOS LIMITES 

A ABNT NBR 8800:2008 considera dois estados-limites que serão detalhados a 

seguir conforme explicitado na referida norma. 

2.4.1 Estado Limite Último – ELU 

Segundo a ABNT NBR 8800:2008, o estado limite último está relacionado à 

segurança da estrutura ao ser submetida à combinação de ações mais desfavorável.  

Com base em Fakury (2016) apud Santana (2018), estado limite último é a 

capacidade da estrutura em suportar plenamente as ações a que esta for submetida, 

a ocorrência do Estado limite último – ELU, está atrelada ao colapso total ou parcial. 

2.4.2 Estado Limite de Serviço – ELS 

Já o estado limite de serviço, de acordo com a ABNT NBR 8800:2008, está 

relacionada ao desempenho da estrutura ao longo de sua vida útil sob condições 

normais de utilização. 

De acordo com a ABNT NBR 8681, são estados que, por sua ocorrência, repetição 

ou duração, causam efeitos estruturais que desrespeitam as condições adequadas 

para o uso da construção, ou que são indícios de comprometimento da durabilidade 

da estrutura. 
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2.5 ESBELTEZ 

De acordo com a ABNT NBR 8800: 2008, esbeltez (λ) é a razão entre largura e 

espessura (b/t) dos elementos comprimidos em perfis metálicos. De acordo com os 

valores de esbeltez (λ), as seções são classificadas em: 

a) compactas – seções cujos valores de λ são inferiores a λp; 

b) semicompactas – seções em que λ é superior a λp, porém inferior a λr; 

c) esbelta – seções cujos valores de λ são superiores a λr. 

2.6 TRAÇÃO 

Peças tracionadas são aquelas sujeitas a esforços de tração simples e tração axial, 

com base em Pfeil e Pfeil (2009) apud Santana (2018), estas peças são empregadas 

nas estruturas sob as formas de: 

Tirantes ou pendurais; 

Contraventamentos de torres; 

Travejamentos de vigas ou colunas; 

Tirantes de vigas armadas; e 

Barras tracionadas de treliças. 

A NBR ABNT 8800: 2008, p. 43, estabelece a seguinte condição para barras 

submetidas à força axial de tração: 

Nt,Sd ≤ Nt,Rd                                                                                                                  (1) 

Sendo: 

Nt, Sd – força axial de tração solicitante de cálculo; 

Nt, Rd – força axial de tração resistente de cálculo; 
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Ainda conforme a norma, o índice de esbeltez das barras submetidas a tração, 

deverá ser menor que 300, isto é, a relação (L / r), sendo “L” o comprimento 

destravado e “r” o raio de giração. 

2.7 COMPRESSÃO 

Com base em Fakoury (2016), as barras de aço comprimidas axialmente, aparecem 

compondo vigas e pilares treliçados, assim como, em alguns tipos de 

contraventamento. Além disso, o autor cita dois modos de colapso a serem 

considerados, a instabilidade da barra como um todo e a flambagem local dos 

elementos que compõe a seção transversal da barra (flambagem da alma ou 

flambagem das mesas, por exemplo, em uma seção H). 

A ABNT NBR 8800: 2008, aplica a seguinte condição geral para as barras 

prismáticas submetidas a força normal de compressão: 

Nc,Sd ≤ Nc,Rd                                                                                                                 (2) 

Nc,Sd – Força axial de compressão solicitante de cálculo; 

Nc,Sd – Força axial de compressão solicitante de cálculo; 

A norma também estabelece que para perfis submetidos a esforço axial de 

compressão, o índice de esbeltez seja limitado a 200, tomando como relação (K.L/r), 

sendo “K” coeficiente de flambagem dado na Tabela 2, “L” o comprimento de 

flambagem e “r” é o raio de giração da peça. 
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Tabela 2: Coeficiente de flambagem por flexão 

 

Fonte: (Associação Brasileira de Normas Técnicas NBR 8800:2008, p. 125) 

2.8 FLEXÃO 

No caso do esforço de flexão, é importante determinar os esforços atuantes na peça. 

Segundo Pinheiro (2005), é possível classificar a flexão conforme os esforços que 

atuam na barra, da seguinte forma: 

2.8.1 Flexão Pura 

Neste caso, somente o momento fletor atua na barra e pode ser dividida em:  

- Plana: o plano de atuação do momento fletor coincide com um dos planos 

principais de inércia. 

- Oblíqua: o plano de atuação do momento fletor é inclinado em relação aos planos 

principais de inércia. 

2.8.2 Flexão Simples 

Neste caso, existe a atuação do momento fletor e da força cortante. 

2.8.3 Flexão Composta 

Neste caso, o momento fletor atua com ou sem a força cortante, sendo combinado 

com o momento torsor, ou com a força normal, ou ambos. 
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2.9 MOMENTO FLETOR RESISTENTE DE CÁLCULO 

Ao dimensionar uma barra submetida a momento fletor, é necessário satisfazer a 

seguinte relação: 

MSd ≤ MRd                                                                                                                   (3) 

Sendo MSd o momento fletor solicitante de cálculo, e MRd o momento fletor resistente 

de cálculo que é dado pela razão entre o momento fletor resistente nominal e o 

coeficiente de ponderação igual a 1,10, dado pela norma brasileira, NBR 8800:2008. 

Os estados-limites básicos são FLT, FLM e FLA, e serão explicitados a seguir, 

conforme Fakoury (2016). 

2.9.1 Flambagem Lateral por Torção– FLT 

Quando barras de aço são submetidas à momento fletor crescente em relação ao 

eixo x (maior inércia), a torção e a curvatura (flambagem) aumentam gradativamente 

até o colapso. 

É estabelecido pela NBR ABNT 8800:2008 para cada tipo de seção e eixo, para o 

estado-limite de Flambagem Lateral com Torção, o momento fletor resistente de 

cálculo a seguir: 

MRd = 
Mpl

γa1
, para λ ≤ λp                                                                                                 (4) 

MRd = 
Cb

γa1
x[Mpl-(Mpl-Mr)x

λ-λp

λr- λp

] ≤  
Mpl

γa1
, para λp< λ ≤ λr                                                (5) 

MRd= 
Mcr

γa1
 ≤ 

Mpl

γa1
, para λ >λr                                                                                           (6) 

Sendo: 

Mpl: Momento fletor de plastificação; 

γa1: coeficiente de ponderação dado pela tabela 3 da ABNT NBR 8800:2008, p. 23; 

Cb: Fator de modificação para diagrama de momento fletor não-uniforme, obtido 

segundo ABNT NBR 8800:2008, p. 47; 
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Mr: momento fletor correspondente ao início do escoamento, incluindo a influência 

das tensões residuais (exceto para flambagem local da mesa); 

Mcr: momento fletor de flambagem elástica; 

λr: parâmetro de esbeltez correspondente ao início do escoamento; e 

λp: parâmetro de esbeltez correspondente a plastificação. 

A norma ainda estabelece a seguinte relação, a fim de limitar o fenômeno de FLT: 

λm = Lb / ry                                                                                                                (7) 

Sendo: 

Lb = comprimento longitudinal sem contenção lateral, do perfil 

Ry = raio de giração, em relação ao eixo principal de inércia, perpendicular ao eixo 

de flexão 

λm = parâmetro de esbeltez 

2.9.2 Flambagem Local das Mesas (FLM) e Flambagem Local da Alma 

(FLA) 

Nos casos em que o FLM e FLA são estados-limites últimos aplicáveis, dá-se o 

momento fletor resistente nominal por, segundo a ABNT NBR 8800:2008: 

- λ ≤ λp: MRk = Mpl                                                                                                       (8) 

- λp< λ ≤ λr: MRk = Mpl – (Mpl – Mr)(λ – λp)/( λr – λp)                                                    (9) 

- λ >λr: MRk = Mcr                                                                                                      (10) 

Toma-se o maior valor de MSd para toda a viga e seu MRd, e faz-se a verificação uma 

única vez, devendo atender à condição expressa pela seguinte equação: 

MSd ≤ MRd                                                                                                                (11) 

O índice de esbeltez para FLA e FLM devem ser verificados, conforme a seção 

transversal, com as respectivas equações a seguir: 
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Para FLA: λa = h/tw                                                                                               (12) 

Considerando: 

h = altura da alma; 

λa = esbeltez; e 

tw = espessura da alma. 

Para FLM: λm = (bf/2) / tf                                                                                       (13) 

Sabendo que: 

λm = esbeltez; 

bf: largura da mesa; e 

tf: espessura da mesa. 

2.10 CISALHAMENTO 

A ABNT NBR 8800:2008 estabelece a condição a seguir, para dimensionamento de 

perfis à força cortante: 

VSd ≤ VRd                                                                                                                                                                           (14) 

Sendo: 

VRd – força cortante resistente de cálculo, dado pela razão entre a força cortante 

resistente nominal e o coeficiente de ponderação igual a 1,10, estabelecido pela 

norma. 

VSd – força cortante solicitante de cálculo 
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2.11 DESLOCAMENTO MÁXIMO 

A ABNT NBR 8800:2008 estabelece os deslocamentos máximos de acordo com a 

Tabela 3. 

Tabela 3: Deslocamentos máximos 

 

Fonte: (Associação Brasileira de Normas Técnicas NBR 8800:2008, p. 117) 

A norma ainda define ς0 como a contra flecha, ς1 é a contra flecha decorrente de 

forças permanentes de baixa duração, ς2 é o deslocamento devido a carregamentos 

permanentes de longa duração e ς3 é a contra flecha por conta de ações variáveis, 

além disso, ςmax é o deslocamento máximo da viga. 

3. DESCRIÇÃO DO MODELO 

O galpão será de duas águas com vão livre de 12 metros por 3 vãos de 6 metros, 

fechamento em alumínio e perfis metálicos. A escolha dos perfis foi feita a partir de 

um pré-dimensionamento utilizando o SAP 2000, esta ferramenta funciona a partir 

da inserção de perfis, de uma biblioteca contida no computador do usuário, a fim de 

criar um banco de dados no programa, a partir desta importação, deve-se criar um 
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perfil de auto seleção de determinada geometria, nesse caso, tipo H e C,,e associar 

à cada um, os perfis importados, com a geometria respectiva, dentre os quais, o 

software irá selecionar a opção mais adequada para cada barra, com base na norma 

escolhida pelo usuário, no caso de usuários brasileiros, a norma correta a ser 

escolhida deve ser a AISC360 05/IBC2006, que é similar à NBR 8800:2008, já que a 

norma brasileira não consta no programa. 

Neste caso, foram selecionados os seguintes perfis: HP 200x53,0 para as colunas, U 

– 305 x 30,80 para as terças e vigas horizontais, U – 76,20 x 6,10 para os montantes 

e W – 150 x 22,5 para as vigas inclinadas, todos os perfis provém de catálogos 

Gerdau, contidos no Anexo A deste trabalho, fabricados segundo a ABNT NBR 

15980:2011. 

Enquanto o aço escolhido está contido na Tabela A.2 do Anexo A da ABNT NBR 

8800:2008 e foi inserida no Anexo B do presente trabalho, trata-se do aço-carbono 

A36 cujas propriedades de resistência ao escoamento e resistência à ruptura são, 

respectivamente, 250 MPa e 400 Mpa. As telhas foram escolhidas com base em um 

catálogo inserido no Anexo A deste trabalho e seu peso é de 5,85 kg/m. As 

dimensões do galpão estão expostas nas Figuras 4 e 5. 

Figura 4: Cotas da vista frontal do galpão 

 
Fonte: (o autor) 

Figura 5: Cotas da vista superior do galpão 

 
Fonte: (o autor) 
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Dados geométricos da edificação, legendados na Figura 6: 

b = 12,00 m; a = 18,00 m; h = 3,00 m; h1 = 1,06 m; ß = 10,00 ° e d = 6,00 m. 

Sendo: 

b – Dimensão frontal do galpão 

a – Dimensão longitudinal do galpão 

h – Altura 

h1 – Altura do montante 

ß – Inclinação 

d – Distância entre pórticos 

Figura 6: Legenda do galpão 

 

Fonte: (o autor) 

As cargas incidentes na estrutura são as seguintes: 

3.1 PESO PRÓPRIO 

O peso próprio é a carga permanente da estrutura, sendo definida pela soma do 

peso de cada perfil mais o peso das telhas, sendo: 

g = gcoluna + gterça+ gvigas inclinadas + gvigas horizontais + gmontante + gtelhas                            (15) 
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Sendo: 

g – Peso próprio, dado nas tabelas de perfil e telha 

Este peso é determinado diretamente pelo SAP 2000. 

3.2 VENTO 0° E 90° 

O esforço proveniente da ação do vento pode ser determinado a partir da ABNT 

NBR 6123:1988 – Forças devidas ao vento em edificações, da seguinte maneira, 

considerando os dados geométricos, previamente apresentados: 

b1 = 2h = 2 x 3,00 = 6,00 m; ou                                                                               (16) 

b1 = b/2 = b1 = 12,00/2 = b1 = 6,00 m                                                                    (17) 

Adota-se o menor valor, portanto, b1 = 6,00 m  

Em seguida, 

a1 = b/3 = 12,00/3= 4,00 m; ou                                                                              (18) 

a1 = a/4 = 18,00/4= 4,50 m                                                                                    (19) 

Adota-se o maior valor, porém a1 ≤ 2h = 6,00, portanto a1 = 4,50 m 

a2 = (a/2) – a1= (18,00/2) – 4,50 = 4,50 m                                                           (20) 

A velocidade característica do vento calcula-se da seguinte maneira: 

Vk = Vo x S1 x S2 x S3                                                                                         (21) 

Sendo: 

Vo – velocidade básica do vento, em m/s 

S1 – Fator topográfico 

S2 – Fator de rugosidade 
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S3 – Fator estatístico 

Todos os parâmetros são provenientes de gráficos e tabelas contidos no anexo C 

deste trabalho, dessa forma, 

Vo = 30,00 m/s  

Considerando o terreno plano ou fracamente acidentado, o fator topográfico será S1 

= 1,00. Enquanto o fator de rugosidade (S2) é definido a seguir, como o galpão 

pertence à categoria IV e classe A, apresenta-se os parâmetros retirados da Tabela 

2 da NBR6123/88 que relaciona Categoria e Classe: 

b = 0,86; Fr = 1,00; e p = 0,12; logo: 

S2 = b Fr (z/10)p                                                                                                        (22) 

S2 = 0,86 x 1,00 (4,06/10)0,12= 0,77                                                                        (23) 

Em seguida, calcula-se o fator estatístico (S3), sabendo que a estrutura se encontra 

no grupo 3, este possui o valor de S3 = 0,95. Apresenta-se os coeficientes de 

pressão externa para as paredes, nas Figuras 7 e 8. 

Vento 0° 

Figura 7: Vento 0° nas paredes 

 

Fonte: (o autor) 
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Vento 90° 
Figura 8: Vento 90° nas paredes 

 
Fonte: (o autor) 

Para o telhado, os valores estão expostos nas Figuras 9 e 10: 
Vento 0° 

Figura 9: Vento 0° no telhado 

 
Fonte: (o autor) 
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Vento 90° 
Figura 10: Vento 90° no telhado 

 
Fonte: (o autor) 

Logo, Cpe médio = -0,90 
 
Para o coeficiente de pressão interno, tem-se 
Cpi 1 = -0,30; e Cpi 2 = 0,00 
 
O cálculo da velocidade característica de vento está discriminado a seguir: 
Vk = 30,00 x 1,00 x 0,77 x 0,95 = 22,00 m/s                                                            (24) 
 
Dessa forma, a pressão dinâmica é: 
q = 0,613Vk²                                                                                                             (25) 
q = 0,613 x 22,00²= 0,30 kN/m² 
 

Nas Figuras 11, 12, 13 e 14, apresentam-se os esforços resultantes 

Vento 0° - Cpi = -0,30 

Figura 11: Vento 0° - cpi = -0,30 

 

Fonte: (o autor) 
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Vento 0° - Cpi = 0,00 

Figura 12: Vento 0° - cpi = 0 

 

Fonte: (o autor) 

Vento 90° - Cpi = -0,30 

Figura 13: Vento 90° - cpi = -0,30 

 

Fonte: (o autor) 

Vento 90° - Cpi = 0,00 

Figura 14: Vento 90° - cpi = 0 

 

Fonte: (o autor) 
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O pior caso para o vento 0° e 90° é com cpi = 0, logo, ao dividir os valores dos 

esforços no telhado pela distância entre os pórticos, encontra-se o valor do esforço 

para cada área de influência, este será o valor inserido no SAP 2000. Ao dividir, 

obtém-se, para o vento 90°, 0,357 KN/m2 para o lado esquerdo do telhado e 0,118 

KN/m2 para o lado direito, enquanto, para o vento 0°, tem-se 0,237 KN/m2 para 

ambos os lados. 

3.3 SOBRECARGA NA COBERTURA 

A sobrecarga aplicada na cobertura é definida, também, pela ABNT NBR 6123:1988 

– Forças devidas ao vento em edificações, e equivale a 0,25 KN/m2, trata-se de uma 

carga extra que deve ser considerada a fim de favorecer a segurança da edificação. 

3.4 COMBINAÇÕES 

Consideram-se 6 combinações de ações, sendo g o peso próprio, como segue: 

Com a sobrecarga na cobertura (q) como carga variável principal, 

Combinação 1 = 1,25g + 1,5q + 0,84W0                                                                  (26) 

Combinação 2 = 1,25g + 1,5q + 0,84W90                                                                 (27) 

Sendo o vento 0° (W0), a carga variável principal 

Combinação 3 = 1g + 1,4W0                                                                                    (28) 

Combinação 4 = 1,25g + 1,4 W0 + 1,2q                                                                   (29) 

Considerando o vento 90° (W90) como carga variável principal 

Combinação 5 = 1g + 1,4W90                                                                                   (30) 

Combinação 6 = 1,25g + 1,4W90 + 1,2q                                                                   (31) 

Nota-se que a pior combinação é a 6. 
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3.5 VERIFICAÇÕES 

A partir dos esforços críticos gerados no SAP 2000, construiu-se a Tabela 4 para 

expô-los e posterior verificação. 

Tabela 4: Esforços críticos 

Esforços Esforço 

Axial (KN) 

Momento 

Fletor 

(KN.m) 

Cisalhamento 

(KN) 

Torção 

(KN/m) 

Deflexão 

(m) 
Elementos 

Colunas - 36,86 0,246 0,16 0 0 

Vigas 

Horizontais 
5,099 0,012 0,004 0 8,42 x 10-6 

Vigas 

Inclinadas 
- 1,18 0,037 0,049 0 4,64 x 10-6 

Terças 

0,963 

- 0,601 

1,81 1,35 0,07 0,00012 

Montantes -32,65 0,0037 0,007 0 0 

Fonte: (o autor) 

3.5.1 Tração 

As peças expostas ao esforço de tração são  as vigas horizontais e algumas terças, 

dessa forma, segundo o item 2.6 deste trabalho, equação 1, a seguinte condição a 

ser atendida requer que a força axial de tração solicitante de cálculo seja menor ou 

igual à força axial de tração resistente de cálculo, a seguir será calculada a força 

resistente de cálculo a fim de comparar com a força solicitante discriminada na 

Tabela 4 e determinar se atende à condição imposta pela ABNT NBR 8800:2008, 

para cada elemento tracionado. 
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Escoamento da seção bruta 

Nt,Rd= (Agfy)/𝛾a1                                                                                                         (32) 

Sendo: 

Ag – Área bruta da seção transversal 

fy – Resistência ao escoamento do aço, vide Tabela A.2 do Anexo A da ABNT NBR 

8800:2008 

𝛾a1 – coeficiente de ponderação da resistência, igual a 1,10, segundo ABNT NBR 

8800:2008 

Ruptura da seção líquida 

Nt,Rd = (Aefu)/𝛾a2                                                                                                        (33) 

Sendo: 

Ae – Área líquida efetiva da seção transversal da barra 

fu – Resistência à ruptura do aço, vide Tabela A.2 do Anexo A da ABNT NBR 

8800:2008 

𝛾a2 – coeficiente de ponderação da resistência, igual a 1,35, segundo ABNT NBR 

8800:2008 

Para as vigas horizontais: 

Nt,Rd = (39,30x10-4x250x106)/1,1 = 893181,82 N = 893,18 KN >5,099 KN OK        (34) 

Nt,Rd = (39,30x10-4x400x106)/1,35 = 1164444,44 N = 1164,44 KN >5,099KN OK   (35) 

Para as terças: 

Nt,Rd = (39,30x10-4x250x106)/1,1 = 893181,82 N = 893,18 KN >0,308 KN OK        (36) 

Nt,Rd = (39,30x10-4x400x106)/1,35 = 1164444,44 N = 1164,44 KN>0,308 KN OK   (37) 
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A próxima verificação é quanto ao limite do índice de esbeltez, deve-se obedecer a 

seguinte condição: 

L/r < 300                                                                                                                   (38) 

Sendo: 

L – Comprimento destravado 

r – raio de giração da peça 

Para as vigas horizontais: 

Direção x: 600/11,70 = 51,28< 300 OK                                                                    (39) 

Direção y: 600/2,03 = 295,57 < 300 OK                                                                   (40) 

Para as terças: 

Direção x: 600/11,70 = 51,28 < 300 OK                                                                   (41) 

Direção y: 600/2,03 = 295,57 < 300 OK                                                                   (42) 

Desta forma, verifica-se a estabilidade das peças quanto à tração. 

3.5.2 Compressão 

As peças comprimidas são as colunas, as vigas inclinadas, os montantes e algumas 

terças, para fazer a verificação, deve-se obedecer às seguintes condições: 

Nc,Sd ≤ Nc,Rd                                                                                                               (43) 

Nc,Rd = (ꭕQAgfy)/𝛾a1(44) 

𝜆0 = √
QAgfy

Ne
                                                                                                                (45) 

Para 𝜆0 ≤ 1,5: ꭕ = 0,6580,658𝜆02

                                                                                 (46) 
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Para 𝜆0 >1,5: ꭕ = 0,877/𝜆0
2                                                                                          (47) 

Ne = (π2EI)/(kL)2                                                                                                      (48) 

Sendo, 

Nc,Sd – força axial de compressão solicitante de cálculo 

Nc,Rd – força axial de compressão resistente de cálculo 

ꭕ - Fator de resistência à compressão 

Q – Fator de redução total associado à flambagem local 

Ne – força axial de flambagem elástica, obtida conforme o Anexo E, da ABNT NBR 

8800:2008 

E – Módulo de elasticidade do aço, igual a 20000 KN/cm2 

K – Coeficiente de flambagem, dado na Tabela E.1 do Anexo E da ABNT NBR 

8800:2008 

Verificação das colunas: 

Como trata-se de um perfil H, a barra enquadra-se no Grupo 2 da Tabela F.1 do 

Anexo F da ABNT NBR 8800:2008, logo, a esbeltez da alma é: 

b/t = 19,85 < (b/t)lim = 1,49 √
20000

25
 = 42,14                                                                (49) 

Sendo b, o comprimento da alma e t, a espessura desta. Enquanto a esbeltez das 

mesas que está no Grupo 4 da mesma tabela, dá-se a seguir: 

b/t = 9,16 < (b/t)lim = 0,56  √
20000

25
 = 15,84                                                                 (50) 

Como a relação b/t é menor que o limite dado pela norma, Q = 1. Em seguida 

calcula-se a força axial de flambagem elástica no eixo x e y, sendo: 

KxLx = KyLy = 0,7 x 300 = 210 cm                                                                             (51) 
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Nex = (π2x20000x4977)/2102 = 22277,11 KN                                                           (52) 

Ney = (π2x20000x1673)/2102 = 7488,37 KN                                                             (53) 

𝜆0 = √
1x68,1x25

7488,37
 = 0,48 < 1,5, logo, ꭕ = 0,91                                                               (54) 

Nc,Rd = (0,91x1x68,1x25)/1,1 = 1408,43 KN >36,86 KN OK                                    (55) 

Verificação das vigas inclinadas: 

Os valores de (b/t)lim são iguais aos calculados anteriormente por se tratar de perfil 

H. Esbeltez da alma, 

b/t = 20,48 < (b/t)lim = 42,14                                                                                     (56) 

Esbeltez das mesas, 

b/t = 11,52 < (b/t)lim = 15,84                                                                                     (57) 

Logo, Q = 1 

KxLx = KyLy = 1 x 609 = 609 cm                                                                               (58) 

Nex = (π2x20000x1229)/6092 = 654,10 KN                                                              (59) 

Ney = (π2x20000x387)/6092 = 205,97 KN                                                                (60) 

𝜆0 = √
1x29x25

205,97
 = 1,88 > 1,5, logo, ꭕ = 0,25                                                                 (61) 

Nc,Rd = (0,25x1x29x25)/1,1 = 164,77 KN >1,81 OK                                                 (62) 

Verificação dos montantes: 

O cálculo do (b/t)lim para alma e mesas, é igual ao que foi feito para as colunas, pois 

o perfil C encaixa-se no mesmo grupo de perfis H.  

Esbeltez da alma, 

b/t = 14,43 < (b/t)lim = 42,14                                                                                     (63) 



42 
 

Esbeltez das mesas, 

b/t = 5,17 < (b/t)lim= 15,84                                                                                        (64) 

Logo, Q = 1 

KxLx = KyLy = 1 x 105,75 = 105,75 cm                                                                     (65) 

Nex = (π2x20000x68,90)/105,752 = 1216,15 KN                                                      (66) 

Ney = (π2x20000x8,20)/105,752 = 144,74 KN                                                          (67) 

𝜆0 = √
1x7,78x25

144,74
 = 1,16 < 1,5, logo, ꭕ = 0,69                                                               (68) 

Nc,Rd = (0,69x1x7,78x25)/1,1 = 122,00 KN >32,65 OK                                            (69) 

Verificação das terças: 

O cálculo do (b/t)lim para alma e mesas, é igual ao que foi feito anteriormente.  

Esbeltez da alma, 

b/t = 38,83 < (b/t)lim = 42,14                                                                                     (70) 

Esbeltez das mesas, 

b/t = 5,83 < (b/t)lim= 15,84                                                                                        (71) 

Logo, Q = 1 

KxLx = KyLy = 0,7 (600 – 152) = 313,6 cm                                                               (72) 

Nex = (π2x20000x5370)/313,62 = 10778,34 KN                                                       (73) 

Ney = (π2x20000x161)/313,62 = 323,15 KN                                                             (74) 

𝜆0 = √
1x39,30x25

323,15
 = 1,74 > 1,5, logo, ꭕ = 0,29                                                             (75) 

Nc,Rd = (0,29x1x39,30x25)/1,1 = 259,02 KN >0,601 OK                                         (76) 

A próxima verificação é quanto ao limite de esbeltez: 
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Para as colunas 

L/rx = 300/8,55 = 35,09 < 200 OK                                                                            (77) 

L/ry = 300/4,96 = 60,48 < 200 OK                                                                            (78) 

Para as vigas inclinadas 

L/rx = 609/6,51 = 93,55 < 200 OK                                                                            (79) 

L/ry = 609/3,65 = 166,85 < 200 OK                                                                          (80) 

Para os montantes: 

L/rx = 106/2,98 = 35,57 < 200 OK                                                                            (81) 

L/ry = 106/1,03 = 102,91 < 200 OK                                                                          (82) 

Para as terças: 

L/rx = 313,6/11,70 = 26,80 < 200 OK                                                                       (83) 

L/ry = 313,6/2,03 = 154,48 < 200 OK                                                                       (84) 

Após os cálculos, contata-se que os elementos comprimidos atendem às 

necessidades para as quais foram projetados. 

4. MODELAGEM DE UM GALPÃO METÁLICO NO SAP 2000 V.16 

Neste capítulo apresentar-se-á o tutorial detalhado para a modulação de um galpão 

com estruturas em perfis metálicos, no SAP 2000 v.16, trata-se de um software para 

dimensionamento e análise computacional de estruturas, utilizando o método de 

subdivisões da estrutura em partes para realização dos cálculos, extremamente 

utilizado por engenheiros civis e profissionais da área, pois é um programa completo, 

que calcula desde pequenas estruturas, até estruturas de grande porte, mais 

complexas, utilizando elementos de barra. 
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A fim de apresentar resultados confiáveis quando alimentado com informações da 

maneira correta, o SAP 2000 usa normas internacionais de cálculo estrutural, para 

realizar seus cálculos. Como não é possível selecionar a norma brasileira de 

estruturas metálicas pois esta não consta no programa, pode-se escolher a norma 

AISC360 05/IBC2006 que é semelhante à nossa para que a estrutura seja analisada 

e/ou dimensionada. 

4.1 SELEÇÃO DO TEMPLATE 

Ao iniciar o programa, clica-se em File -> New Model como mostrado na Figura 15, 

em seguida deve-se selecionar as unidades em que o SAP 2000 irá trabalhar e no 

campo Select Template seleciona-se Grid Only, como exposto na Figura 16. 

Figura 15: Seleção do novo modelo 

 

Fonte: (o autor) 
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Figura 16: Seleção das unidades e template 

 

Fonte: (o autor) 

Em seguida, uma caixa de diálogo Quick Grid Lines aparecerá, conforme a Figura 

17, nela serão inseridos o número de linhas de base em cada eixo, assim como a 

distância entre elas, as medidas serão conforme a seleção de unidades feita 

anteriormente. 

Os valores a serem inseridos no campo Number of Grid Lines em X Direction, Y 

Direction e Z Direction são 3, 4 e 3, respectivamente, da mesma forma, no campo 

Grid Spacing, deve-se inserir os seguintes valores nas lacunas: X Direction (6); Y 

Direction (6) e Z Direction (3). O terceiro campo refere-se às coordenadas de 

localização da primeira linha de base, mantem-se o valor 0 em todas as lacunas 

para que o desenho se inicie na origem do plano cartesiano. Em seguida, clica-se 

em OK e a caixa de diálogo será fechada. 
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Figura 17: Inserção do número de linhas de base e distância entre elas 

 

Fonte: (o autor) 

A fim de alterar a medida de uma única linha de base para fazer o desenho da 

cobertura corretamente, deve-se clicar, tela atual, com o botão direito do mouse e 

selecionar Edit Grid Data na caixa de diálogo aberta, conforme Figura 18. 

Figura 18: Edição das linhas de base 

 

Fonte: (o autor) 

Em seguida, aparecerá a janela Coordinate/Grid Systems, na qual deve-se clicar 

na aba Modify/Show System, como mostrado na Figura 19, que abrirá outra janela, 

na qual serão verificados os valores de X Grid Data, Y Grid Data e Z Grid Data, 
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nesse último campo, deve-se alterar o valor de Z3 para 4,0575, conforme Figura 20. 

Ao clicar em OK nas duas janelas abertas, aparecerá o desenho inicial, como 

mostrado na Figura 21. 

Figura 19: Modificar linhas de base 

 

Fonte: (o autor) 

Figura 20: Inserção do valor de Z3 

 

Fonte: (o autor) 
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Figura 21: Linhas de base definidas 

 

Fonte: (o autor) 

4.2 DEFINIÇÃO DOS MATERIAIS E PERFIS 

A definição dos materiais é feita da seguinte maneira, clica-se em Define, na paleta 

superior, em seguida na opção Materials->Add New Material. Abrir-se-á a janela 

Add Material Property, mostrada na Figura 22, na qual deve-se alterar os campos 

Region->United States, Material Type->Steel, Standard->ASTM36 e Grade-

>Grade 36. Clicar em OK para finalizar o comando. 

Figura 22: Criação do material aço usado na estrutura 

 

Fonte: (o autor) 

Na janela Define Materials clica-se em Modify/Show Material. Em General Data, 

alterar o item Material Name and Display Color para Aço, conforme Figura 23. 

Clicar em OK para voltar à caixa de diálogo. 
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Figura 23: Propriedades do aço 

 

Fonte: (o autor) 

Seguindo o mesmo passo a passo anterior, para adicionar o material do fechamento 

superior, clica-se em Add New Material, alterar os campos Region->United States, 

Material Type->Aluminio, Standard->ASTM e Grade->Grade Alloy 6061 T6, de 

acordo com a Figura 24. Clicar em OK. Selecionar Modify/Show Material e alterar o 

campo Material Name Display Color para Alumínio, segundo Figura 25. Clicar em 

OK nas duas janelas. 

Figura 24: Criação do material alumínio usado no fechamento superior 

 

Fonte: (o autor) 
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Figura 25: Propriedades do alumínio 

 

Fonte: (o autor) 

Em seguida, para fazer a seleção dos perfis para cada barra, clica-se em Define-

>SectionProperties->Frame Sections conforme mostrado na Figura 26, para abrir 

uma caixa de diálogo Frame Properties, nessa deve-se selecionar Import New 

Property para importar seções de barras a partir de uma biblioteca de perfis dos 

tipos I e C. 

Figura 26: Definição das seções das barras 

 

Fonte: (o autor) 
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No campo Click To Import a Steel Section deve-se selecionar I/Wide Flange, 

como na Figura 27, em seguida será aberta uma caixa de diálogo Section Property 

File, nessa selecionar-se-á o documento ACOMINAS.PRO e Abrir, em seguida, 

conforme Figura 28. 

Figura 27: Importação do perfil I 

 

Fonte: (o autor) 

Figura 28: Seleção da biblioteca de perfis I 

 

Fonte: (o autor) 
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Uma nova caixa de diálogo será aberta, na qual deve-se selecionar o material Aço 

e, no campo Select Section To Import seleciona-se todas as seções e clica-se em 

OK duas vezes, ilustrado na Figura 29. 

Figura 29: Seleção dos perfis a serem importados 

 

Fonte: (o autor) 

Seguindo o tutorial feito anteriormente para importar os perfis I, deve selecionar 

Channel na caixa de diálogo Import Frame Section Property, conforme Figura 30, 

após clicar em OK na caixa de diálogo que indica um erro, então será aberta uma 

nova janela ChannelSection, como ilustrado na Figura 31, nessa clica-se em Open 

File, em seguida, seleciona-se SECTIONS8.PRO e Abrir, mostrado na Figura 32. 

Figura 30: Importação do perfil C 

 

Fonte: (o autor) 
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Figura 31: Seção C 

 

Fonte: (o autor) 

Figura 32: Seleção da biblioteca de perfis C 

 

Fonte: (o autor) 

Seguindo o que foi feito anteriormente, deve-se selecionar Aço em Material e, no 

campo Select Section To Import seleciona-se todos os perfis, em seguida, OK, 

conforme Figura 33. 
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Figura 33: Seleção dos perfis a serem importados 

 

Fonte: (o autor) 

A seguir, na caixa de diálogo Frame Properties, será possível visualizar opções de 

perfis do tipo I e C disponíveis, clica-se em OK para fechar a janela. 

4.3 DESENHO DOS ELEMENTOS 

Para desenhar os elementos, seleciona-se Draw Frame/Cable, na paleta lateral 

esquerda que abrirá uma caixa de diálogo, Figura 34, Properties Of Object-

>Section->HP200X53.0. Selecionar o plano XZ, depois desenhar as colunas de 

baixo para cima até a segunda altura, de acordo com a Figura 35. 

Figura 34: Propriedade das colunas 

 

Fonte: (o autor) 
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Figura 35: Desenho das colunas 

 

Fonte: (o autor) 

Troca-se em Section->W150X22,5, Figura 36, e faz-se o desenho das vigas de 

baixo para cima, sendo a viga esquerda, da esquerda para direita e a viga direita, da 

direita para a esquerda, como está ilustrado na Figura 37. 

Figura 36: Propriedades das vigas inclinadas 

 

Fonte: (o autor) 

Figura 37: Desenho das vigas 

 

Fonte: (o autor) 
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Após isso, deve-se trocar Section para U-76,20X6,10, Figura 38, e desenhar o 

montante de baixo para cima, de acordo com a Figura 39. 

Figura 38: Propriedades dos montantes 

 

Fonte: (o autor) 

Figura 39: Desenho do montante 

 

Fonte: (o autor) 

Em seguida, seleciona-se as vigas da cobertura para dividi-las em elementos finitos, 

deve-se clicar na paleta superior em Edit->Edit Lines->Divide Frames, assim abrirá 

uma caixa de diálogo Divide Selected Frames. Depois deve-se apertar em 

Last/First Length Ratio (1) e em Number of Frames (4) e clicar em OK, conforme 

a Figura 40. 

 

 

 

 



57 
 

Figura 40: Divisão das vigas em elementos finitos 

 

Fonte: (o autor) 

Para que seja possível visualizar os nós nas vigas, deve-se clicar na opção na paleta 

superior Set Display Options que fará aparecer a caixa de diálogo Display Options 

For Active Window e desmarcar, no campo Joint, a opção Invisible, como 

mostrado na Figura 41. Feito isto, selecionar OK. 

Figura 41: Janela de opções de exibição 

 

Fonte: (o autor) 

Para criação das Terças, selecionam-se os pontos das vigas e clica-se em Edit-

>Extrude->Extrude Points to Frames/Cables... Na janela Extrude Points to 

Lines, colocar em Property For Added Objects (Terca) e, em Increment Data, dx 

(0), dy (-6), dz(0) e Number (6). Clicar em OK, como a Figura 42 ilustra. 
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Figura 42: Extensão dos pontos para criação das terças 

 

Fonte: (o autor) 

A seguir, seleciona-se os elementos finitos das vigas, para uni-los novamente, deve-

se clicar na paleta superior em Edit->Edit Lines->Join Frames. Depois, para que 

não seja possível visualizar os nós nos cabos, deve-se clicar na opção Set Display 

Options, na paleta superior, que fará aparecer a caixa de diálogo Display Options 

For Active Window e marcar, no campo Joint, a opção Invisible. Depois, 

selecionar OK. Na Figura 43, aparecem as terças criadas. 

Figura 43: Terças criadas e elementos selecionados para serem replicados 

 

Fonte: (o autor) 
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Para replicar, seleciona-se todas as peças do modelo, clica-se em Edit->Replicate e 

surgirá a janela Replicate. Na aba Linear coloca na caixa de Number o valor 3 e no 

item dy o valor 6. Em seguida clica-se em OK, como mostrado na Figura 44.  

A Figura 45 apresenta o galpão modelado. 

Figura 44: Replicação dos elementos selecionados 

 

Fonte: (o autor) 

Figura 45: Galpão modelado 

 

Fonte: (o autor) 

A próxima etapa é a orientação dos perfis, para melhor visualização deve-se clicar 

em Set Display Options, na paleta superior, então aparecerá a caixa de diálogo 
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Display Options For Active Window, no campo ViewType seleciona-se a opção 

Extruded, em seguida clica-se em OK, de acordo com a Figura 46. 

Figura 46: Opções de visualização 

 

Fonte: (o autor) 

O tipo de vista selecionado permite a visão do perfil selecionado e seu 

posicionamento, para adequar a posição de cada barra deve-se, primeiro, selecionar 

os montantes, como na Figura 47, e, em seguida, clicar na opção Assign na paleta 

superior, depois clica-se em Frame->Local Axis para que seja aberta uma caixa de 

diálogo Frame Local Axis a Figura 48 mostra a inserção do valor de 90 em Nagle in 

Degrees, depois seleciona-se em OK. 

Figura 47: Seleção dos montantes 

 

Fonte: (o autor) 
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Figura 48: Ângulo de rotação dos montantes 

 

Fonte: (o autor) 

Em seguida, selecionam-se as vigas horizontais, Figura 49, e procede-se da forma, 

anteriormente, indicada, até a caixa de diálogo Frame Local Axis, na qual insere-se 

90 no campo Angle in Degrees, conforme Figura 50, após isto, clica-se em OK. 

Figura 49: Seleção das vigas horizontais 

 

Fonte: (o autor) 
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Figura 50: Ângulo de rotação das vigas horizontais 

 

Fonte: (o autor) 

Para melhor visualização das terças, executa-se o comando View->Set 3D view. 

Em FastView, seleciona-se o plano XY, em Aperture (0), depois seleciona-se OK, 

como indicado na Figura 51. 

Figura 51: Comando para melhor visualização das terças 

 

Fonte: (o autor) 

A seguir, selecionam-se as terças da esquerda, como na Figura 52, pois as da 

direita estão na posição correta. Posteriormente, executa-se o mesmo procedimento 
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anterior até a janela Frame Local Axis, Figura 53, nessa deve-se inserir 180 em 

Angle in Degrees, depois clica-se em OK. 

Figura 52: Seleção das terças 

 

Fonte: (o autor) 

Figura 53: Ângulo de rotação das terças 

 

Fonte: (o autor) 

Após a rotação de todos os elementos, é necessário ajustar a posição das terças 

para que estas fiquem acima das vigas, para isto, selecionam-se as terças da 

esquerda, Figura 54, e procede-se os seguintes comandos Assign->Frame-

>Insertion Point e na janela colocar a opção 8 (Top Center) em Cardinal Point, 

como na Figura 55. Seleciona-se OK. 
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Figura 54: Seleção das terças da esquerda 

 

Fonte: (o autor) 

Figura 55: Comandos para posicionar corretamente as terças esquerdas 

 

Fonte: (o autor) 

A figura 56 mostra as terças da esquerda posicionadas de forma correta. 
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Figura 56: Terças esquerdas posicionadas corretamente 

 

Fonte: (o autor) 

Em seguida, deve-se selecionar as terças da direita, Figura 57, e seguir as mesmas 

instruções anteriores até a janela Frame Insertion Point, na qual deve selecionar a 

opção 2 (Bottom Center) em Cardinal Point, como na Figura 58, depois pressiona-

se OK. 

Figura 57: Seleção das terças da direita 

 

Fonte: (o autor) 
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Figura 58: Comandos para posicionar corretamente as terças direitas 

 

Fonte: (o autor) 

A figura 59 mostra as terças da direita posicionadas de forma correta. 

Figura 59: Terças direitas posicionadas corretamente 

 

Fonte: (o autor) 
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4.4 DEFINIÇÃO DOS APOIOS 

Para definir os apoios, é preciso, primeiro, selecionar os pontos inferiores das 

colunas, em seguida clica-se em Assign->Joint->Restraints para abrir uma caixa 

de diálogo Joint Restraints, Figura 60, nessa deve-se selecionar a primeira opção 

no campo Fast Restraints, por fim, seleciona-se OK. 

Figura 60: Seleção das restrições das colunas 

 

Fonte: (o autor) 

Depois, faz-se a seleção dos pontos superiores das colunas então clica-se, na 

paleta superior, em Analyze->Set Analysis Options e deve-se selecionar a primeira 

opção Space Frame, conforme Figura 61, depois OK. 

Figura 61: Restrições dos pontos superiores das colunas 

 

Fonte: (o autor) 
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Por fim, selecionam-se os pontos superiores e inferiores dos montantes e procede-

se como anteriormente Analyze->Set Analysis Options, na paleta superior, então 

clica-se na quarta opção Space Truss, mostrada na Figura 62, depois OK. 

Figura 62: Restrições nos pontos dos montantes 

 

Fonte: (o autor) 

4.5 INSERÇÃO DO FECHAMENTO NA COBERTURA 

Para criar o material referente as telhas, deve-se clicar em Define->Section 

Properties->Area Sections.  Na caixa de Select Section Type To Add mantém 

Shell e clica-se em Add New Section. Aparecerá a janela Shell Section Data, na 

qual, na lacuna Section Name, coloca-se Alumínio, em Type marca-se Membrane, 

na lacuna Thickness coloca-se Membrane (0,02) e Bending (0,02). No espaço 

Material Name seleciona-se Alumínio e clica-se em OK para finalizar o comando. 

Com isso, retornar-se-á para a janela Area Sections, aperta-se OK novamente. 

Todo procedimento anteriormente exposto, está ilustrado na Figura 63. 
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Figura 63: Criação da seção para cobertura 

 

Fonte: (o autor) 

Na paleta esquerda, seleciona-se o ícone Draw Poly Area que abrirá a janela 

Properties of Objects, nessa, em Section, é escolhido Alumínio e em Drawing 

Control Type atribui-se None<space bar>, como mostrado na Figura 64. 

Selecionam-se, na peça, os nós que fecharão as áreas. Para isso, clica-se nos 

pontos como indicado na figura 65. Para facilitar, utilizam-se as ferramentas Rotate 

3D View, Zoom In One Step, Zoom Out One Step e Pan. Deve-se repetir o 

processo, até preencher, completamente, o telhado. 

Figura 64: Propriedades do objeto 

 

Fonte: (o autor) 
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Figura 65: Desenho da cobertura do galpão 

 

Fonte: (o autor) 

Para tornar invisíveis as linhas de base, clica-se em Define->Coordinate 

System/Grid, em seguida, em Modify/Show System e habilita-se a função Hide All 

Grid Lines e seleciona-se OK duas vezes, mostrado na Figura 66. 

Figura 66: Comando para esconder as linhas de base 

 

Fonte: (o autor) 
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4.6 APLICAÇÃO DE CARGAS 

Para definir os casos de carregamento, clica-se em Define->Load Patterns na barra 

de ferramentas superior da tela que abrirá uma janela, Figura 67. O programa gera, 

automaticamente, uma carga DEAD, que representa o peso próprio da estrutura e, 

por isso, tem o valor 1 no campo Self-Weight Multiplier. Adiciona-se cargas 

nomeadas de Telhas, Type (Dead), Self-Weight Multiplier (0); Sobrecarga na 

Cobertura, Type (Live), Self-Weight Multiplier (0); Vento 0°, Type (Wind), Self-

Weight Multiplier (0), Auto Lateral Load Pattern (None); Vento 9°, Type (Wind), 

Self-Weight Multiplier (0), Auto Lateral Load Pattern (None). Após o 

preenchimento de todas as lacunas de cada carga, deve-se clicar em Add New 

Load Pattern. Então, clica-se em OK para finalizar o comando. 

Figura 67: Definição das cargas 

 

Fonte: (o autor) 

Para inserir o carregamento na estrutura, selecionam-se as áreas do telhado, Figura 

68, e executa-se o caminho Assign->Area Loads->Uniform Shell, marca-se a 

opção Add to Existing Loads, Load Pattern Name (Telhas), Direction (Z), Load  

(-0,0585) e seleciona-se OK, como mostrado na Figura 69.Em seguida, seleciona-se 

as áreas do telhado novamente e segue-se as instruções anteriores, preenchendo 

as lacunas da seguinte maneira, Load Pattern Name (Sobrecarga na Cobertura), 

Direction (Z), Load (-0,25), como na Figura 70, e clica-se em OK. 
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Figura 68: Seleção das áreas da cobertura para aplicação das cargas 

 

Fonte: (o autor) 

Figura 69: Cargas atribuídas às telhas 

 

Fonte: (o autor) 

Figura 70: Sobrecarga atribuída à cobertura 

 

Fonte: (o autor) 

Para adicionar as cargas de vento 0° e 90°, coloca-se no plano 3D, selecionam-se 

as áreas onde a carga será aplicada e executa-se o caminho Assign->Area Loads-

>Uniform Shell, em seguida, marca-se a opção Add to Existing Loads, Load 

Pattern Name (Vento 0°), Direction (Y), Load (-0,237) e clica-se em OK, como na 

Figura 71. Após isto, seleciona-se as áreas direitas da cobertura e executa-se o 
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mesmo caminho anterior, então preenche-se as lacunas da seguinte forma, Load 

Pattern Name (Vento 90°), Direction (X), Load (0,118) e pressiona-se OK, como 

mostrado na Figura 72. Em seguida, seleciona-se as áreas esquerdas da cobertura 

e, após realizar o procedimento feito anteriormente, deve-se preencher as lacunas 

como se segue Load Pattern Name (Vento 90°), Direction (X), Load (0,357) e 

seleciona-se OK, conforme a Figura 73. 

Figura 71: Carga de vento 0° 

 

Fonte: (o autor) 

Figura 72: Carga de vento 90° no lado direito da cobertura 

 

Fonte: (o autor) 

Figura 73: Carga de vento 90° no lado esquerdo da cobertura 

 

Fonte: (o autor) 
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Para inserir as cargas de vento incidentes nas colunas, selecionam-se as colunas da 

direita, Figura 74, e executa-se o comando Assign->Frame Loads->Distributed, 

depois é preciso preencher as lacunas Load Pattern Name (Vento 0°), Coord Sys 

(Local), Direction (2), Load (1,42) e pressiona-se OK, como na Figura 75. 

Figura 74: Colunas da direita selecionadas para inserção do carregamento 

 

Fonte: (o autor) 

Figura 75: Carga de vento 0° incidente nas colunas direitas 

 

Fonte: (o autor) 

Em seguida, repete-se o processo anterior e insere-se as seguintes informações nas 

lacunas Load Pattern Name (Vento 90°), Coord Sys (Local), Direction (2), Load 

(0,71) e clica-se em OK, como na Figura 76. 
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Figura 76: Carga de vento 90° incidente nas colunas direitas 

 

Fonte: (o autor) 

A seguir, selecionam-se as colunas da esquerda, Figura 77, e clica-se em Assign-

>Frame Loads->Distributed, depois se faz necessário preencher os espaços da 

seguinte forma Load Pattern Name (Vento 0°), Coord Sys (Local), Direction (2), 

Load (-1,42) e depois OK, conforme a Figura 78. 

Figura 77: Colunas da esquerda selecionadas para inserção do carregamento 

 

Fonte: (o autor) 

Figura 78: Carga de vento 0° incidente nas colunas esquerdas 

 

Fonte: (o autor) 
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Após repetir o processo anterior, deve-se inserir as seguintes informações Load 

Pattern Name (Vento 90°), Coord Sys (Local), Direction (2), Load (1,25) e clica-se 

em OK, como na Figura 79. 

Figura 79: Carga de vento 90° incidente nas colunas esquerdas 

 

Fonte: (o autor) 

Para inserir as combinações de ações, feitas segundo a ABNT NBR 8800, deve-se 

selecionar Define na paleta superior, depois Load Combinations->Add New 

Combo e inserir 6 combinações de ações, duas considerando a sobrecarga como 

carga variável principal, duas considerando o vento 0° como carga variável principal 

e outras duas considerando o vento 90° como carga variável principal, após inserir 

cada carga e o fator, deve-se clicar em Add e, após adicionar todas as cargas da 

combinação clica-se em OK e repete-se o processo até inserir todas as 

combinações da seguinte maneira, por fim, clica-se em OK, novamente: 

COMB1: DEAD, Scale Factor (1,25); Telhas, Scale Factor (1,25); Sobrecarga na 

cobertura, Scale Factor (1,5); Vento 0, Scale Factor (0,84). Mostrado na Figura 

80. 
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Figura 80: Combinação 1 

 

Fonte: (o autor) 

COMB2: DEAD, Scale Factor (1,25); Telhas, Scale Factor (1,25); Sobrecarga na 

cobertura, Scale Factor (1,5); Vento 90, Scale Factor (0,84). Mostrado na Figura 

81. 

Figura 81: Combinação 2 

 

Fonte: (o autor) 

COMB3: DEAD, Scale Factor (1,00); Telhas, Scale Factor (1,00); Vento 0, Scale 

Factor (1,4). Mostrado na Figura 82. 
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Figura 82: Combinação 3 

 

Fonte: (o autor) 

 

COMB4: DEAD, Scale Factor (1,25); Telhas, Scale Factor (1,25); Sobrecarga na 

cobertura, Scale Factor (1,2); Vento 0, Scale Factor (1,4). Mostrado na Figura 83. 

Figura 83: Combinação 4 

 

Fonte: (o autor) 

COMB5: DEAD, Scale Factor (1,00); Telhas, Scale Factor (1,00); Vento 90, Scale 

Factor (1,4). Mostrado na Figura 84. 
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Figura 84: Combinação 5 

 

Fonte: (o autor) 

COMB6: DEAD, Scale Factor (1,25); Telhas, Scale Factor (1,25); Sobrecarga na 

cobertura, Scale Factor (1,2); Vento 90, Scale Factor (1,4). Mostrado na Figura 

85. 

Figura 85: Combinação 6 

 

Fonte: (o autor) 
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4.7 ANÁLISE DA ESTRUTURA 

Após inserir todas as cargas e combinações, clica-se Run Analysis na paleta 

superior e clica-se em Run Now, como mostrado na Figura 86. 

Figura 86: Realização da análise 

 

Fonte: (o autor) 

Em seguida, clica-se em Steel Frame Design->View/Revise Preferences para 

indicar ao SAP 2000 a norma a ser usada para que se realize a análise das barras, 

seleciona-se AISC360 05/IBC2006 em Design Code, como na Figura 87, e clica-se 

em OK, posteriormente, deve-se selecionar Design na paleta superior, depois Steel 

Frame Design->Start Design/Check of Structure. Para melhor visualização da 

análise estrutural, deve-se selecionar a opção Set Display Options e marcar Not in 

View no campo Areas, para que o fechamento da cobertura não apareça, como 

ilustrado na Figura 88. 
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Figura 87: Definição das preferências 

 

Fonte: (o autor) 

Figura 88: Comando para desabilitar a visualização do fechamento 

 

Fonte: (o autor) 

Por fim, é possível visualizar a análise dos perfis inseridos no SAP 2000 para cada 

elemento estrutural, através de uma paleta de cores que indica os esforços aos 

quais as barras estão sendo submetidas, da seguinte maneira, a cor azul indica que 

a barra está sofrendo um esforço entre 0 e 50% do esforço que esta suporta, ou 

seja, o coeficiente de segurança seria igual a 2. A cor verde indica esforço entre 50% 

e 70%, enquanto na amarela o esforço é de 70% a 90%, o laranja simboliza esforço 

entre 90% e 100% do que o elemento suporta. Já a vermelha indica que o esforço 
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submetido é maior do que a barra é capaz de resistir. Esta paleta é usada para 

indicar ao usuário se o perfil escolhido é adequado. Conforme mostrado na Figura 

89. 

Figura 89: Visualização da análise dos perfis 

 

Fonte: (o autor) 

Outra forma de visualizar o esforço em cada elemento, é Design->Steel Frame 

Design->Display Design Info para abrir uma caixa de diálogo, nessa, deve-se 

selecionar a opção P-M Ratio Colors & Values em Design Output e OK em 

seguida, de acordo com a Figura 90. Na Figura 91, mostra-se o valor exato da razão 

entre o esforço solicitante e o esforço resistente da peça. 

Figura 90: Comando para visualizar cores e valores dos esforços 

 

Fonte: (o autor) 
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Figura 91: Visualização da proporção de esforço em cada barra 

 

Fonte: (o autor) 

Para obtenção das reações nos apoios, é preciso clicar em Display->Show 

Forces/Stresses->Joints. Esse comando abrirá a janela Joint Reactions Forces, 

na qual é possível escolher o caso de carregamento ou combinação de 

carregamento para o qual deseja-se ver as reações. A Figura 92 apresenta as 

reações nos apoios. 

Figura 92: Reações nos apoios 

 

Fonte: (o autor) 

Para visualização da estrutura deformada, é preciso clicar em Display->Show 

Deformed Shape. Essa opção abrirá a janela Deformed Shape que, assim como 

nas reações de apoio, permite selecionar a visualização da deformação de acordo 

com o carregamento selecionado. A Figura 93 mostra a estrutura deformada. 
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Figura 93: Estrutura deformada 

 

Fonte: (o autor) 

Como o programa analisa as barras individualmente, os diagramas, também, são 

individuais. Para visualizá-los, clica-se em Display->Show 

Forces/Stresses>Frames/Cables/Tendons, esta opção abrirá a janela Member 

Force/Stress Diagram For Frames na qual, além de poder escolher o caso de 

carregamento que representa aquele diagrama, pode-se também selecionar as 

componentes daquele diagrama. Ao clicar em OK é possível clicar nas barras do 

modelo com o botão direito do mouse e visualizar os diagramas dessa, na janela 

Diagrams For Frame Object X. a Figura 94 apresenta a estrutura com os 

diagramas. 

Figura 94: Estrutura com diagramas e valores para uma barra 

 

Fonte: (o autor) 
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5. ANÁLISE DOS RESULTADOS 

A Figura 95 ilustra os diagramas de esforço axial da estrutura. 

Figura 95: Diagrama de esforço axial 

 

Fonte: (o autor) 

5.1 COLUNAS 

Os diagramas a seguir, nas Figuras 96 e 97, pertencem às colunas centrais da 

esquerda e direita, neles pode-se perceber que estas colunas sofrem compressão 

de 23,75 KN, não sofrem torção nem deflexão, e estão sob ação de um momento 

fletor máximo de 0,25KN.m, cisalhamento de -0,16 KN, além disto, no diagrama de 

corpo livre é possível ver a carga distribuída de 0,66 KN/m incidente nelas. 

Figura 96: Diagrama 1 de esforços para colunas 

 

Fonte: (o autor) 
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Figura 97: Diagrama 2 de esforços para colunas 

 

Fonte: (o autor) 

Os próximos diagramas, Figuras 98 e 99, são das 4 colunas dos cantos da estrutura. 

Estas colunas estão comprimidas com 14,71 KN, submetidas a força distribuída de 

0,66 KN/m, momento de 0,19KN.m, cisalhamento de -0,13 KN e não está submetida 

à esforços de torção nem deflexão. 

Figura 98: Diagrama 3 de esforços para colunas 

 

Fonte: (o autor) 
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Figura 99: Diagrama 4de esforços para colunas 

 

Fonte: (o autor) 

Os diagramas a seguir, nas Figuras 100 e 101, pertencem às duas colunas do meio 

da estrutura que estão sofrendo compressão de 36,86 KN, carga distribuída de 0,66 

KN/m, nenhum esforço cisalhante, momento fletor nem deflexão. 

Figura 100: Diagrama 5 de esforços para colunas 

 

Fonte: (o autor) 
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Figura 101: Diagrama 6 de esforços para colunas 

 

Fonte: (o autor) 

Os próximos diagramas, mostrados nas Figuras 102 e 103, pertencem às duas 

colunas do extremo da fileira do meio da estrutura que estão sofrendo compressão 

de 25,24 KN, carga distribuída de 0,66 KN/m, nenhum esforço cisalhante, momento 

fletor nem deflexão. 

Figura 102: Diagrama 7 de esforços para colunas 

 

Fonte: (o autor) 
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Figura 103: Diagrama 8 de esforços para colunas 

 

Fonte: (o autor) 

As colunas mais comprimidas são as duas centrais da estrutura, no entanto o maior 

momento fletor está localizado no grupo de colunas centrais da esquerda e direita. 

5.2 VIGAS INCLINADAS 

Os diagramas a seguir, ilustrados nas Figuras 104 e 105, são das vigas externas da 

estrutura, estas estão submetidas ao esforço de tração de 0,55 KN, carga distribuída 

de 4,84x10-2KN/m, momento máximo de -0,04KN.m, esforço de cisalhamento de 

0,05 KN, deflexão 0,00000464 m e não sofrem torção. 

Figura 104: Diagrama 1 de esforços nas vigas inclinadas 

 

Fonte: (o autor) 
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Figura 105: Diagrama 2 de esforços nas vigas inclinadas 

 

Fonte: (o autor) 

Os próximos diagramas, Figuras 106 e 107, são das vigas inclinadas do meio que 

sofrem compressão de 1,18 KN, carga distribuída de 4,84x10-2 KN/m, momento 

fletor de -0,02KN.m, cisalhamento de 0,11 KN, deflexão de 0,0000024 m e não 

sofrem torção. 

Figura 106: Diagrama 3 de esforços nas vigas inclinadas 

 

Fonte: (o autor) 
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Figura 107: Diagrama 4 de esforços nas vigas inclinadas 

 

Fonte: (o autor) 

As vigas inclinadas externas, sofrem mais deflexão, cisalhamento e momento fletor, 

enquanto a carga distribuída é igual em todas as vigas inclinadas. 

5.3 VIGAS HORIZONTAIS 

Os diagramas a seguir, nas Figuras 108 e 109, pertencem às vigas horizontais 

externas, estas sofrem tração de 3,91 KN, momento máximo de -0,01KN.m, 

cisalhamento de -0,00392 KN, deflexão de 0,0000084 m, não estão submetidas a 

carga distribuída nem esforço de torção. 

Figura 108: Diagrama 1 de esforços nas vigas horizontais 

 

Fonte: (o autor) 
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Figura 109: Diagrama 2 de esforços nas vigas horizontais 

 

Fonte: (o autor) 

Enquanto os diagramas seguintes, Figuras 110 e 111, pertencem às vigas 

horizontais do meio que estão tracionadas em 5,099 KN, submetidas a momento 

fletor de -0,006KN.m, cisalhamento de -1,98x10-3KN, deflexão de 0,0000042 m, não 

sofrem torção nem carga distribuída. 

Figura 110: Diagrama 3 de esforços nas vigas horizontais 

 

Fonte: (o autor) 
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Figura 111: Diagrama 4 de esforços nas vigas horizontais 

 

Fonte: (o autor) 

As vigas horizontais do meio estão mais tracionadas que as externas, enquanto as 

vigas externas sofrem mais deflexão. 

5.4 MONTANTES 

Os montantes externos estão comprimidos em 21,03 KN, com carga distribuída de 

7,37 x 10-2, momento fletor de 0,0037KN.m, cisalhamento de 0,007 KN, não sofrem 

torção, nem deflexão. Diagramas nas Figuras 112 e 113. 

Figura 112: Diagrama 1 de esforços nos montantes 

 

Fonte: (o autor) 
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Figura 113: Diagrama 2 de esforços nos montantes 

 

Fonte: (o autor) 

Enquanto os montantes internos estão comprimidos em 32,65 KN, com carga 

distribuída de 7,37 x 10-2, momento fletor de -0,0018KN.m, cisalhamento de 0,0035 

KN, não sofrem torção, nem deflexão. Os diagramas estão nas Figuras 114 e 115. 

Figura 114: Diagrama 3 de esforços nos montantes 

 

Fonte: (o autor) 
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Figura 115: Diagrama 4 de esforços nos montantes 

 

Fonte: (o autor) 

A partir dos resultados, observa-se que os montantes internos sofrem mais 

compressão, enquanto os externos estão sofrendo mais esforços de momento e 

cisalhamento. 

5.5 TERÇAS 

Como a estrutura é simétrica, as terças estão divididas em 10 grupos nos quais, as 

peças pertencentes aos respectivos grupos, possuem os mesmos esforços. O grupo 

1 contém as 4 terças dos dois extremos da estrutura, enquanto o grupo 2 contém as 

terças da posição dois, contando a partir do extremo, dos cantos da estrutura; no 

grupo 3 estão as terças da posição 3, seguindo o mesmo raciocínio anterior, dos 

cantos; o grupo 4 inclui as terças da posição 4 dos cantos da estrutura. 

No grupo 5, estão as 2 terças dos extremos centrais da estrutura, ou seja, entre os 

pórticos do meio; no grupo 6, as terças inseridas, são as da posição 2, contando a 

partir do extremo da estrutura, de ambos os lados; o grupo 7, contém as terças da 

posição 3, seguindo o mesmo raciocínio anterior; já no grupo 8, estão as terças da 

posição 4, dos dois lados da estrutura. No grupo 9, estão as terças da cumeeira dos 
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cantos, 2 peças ao todo, e, por fim, o grupo 4 é composto pela terça do meio da 

cumeeira, totalizando uma peça. 

Os diagramas a seguir, nas Figuras 116 e 117, são das terças do grupo 1, sofrem 

tração de 0,468 KN, torção de 0,0658 KN.m, momento fletor de 1,16KN.m, 

cisalhamento de 1,13 KN e deflexão de 0,00011 m. 

Figura 116: Diagrama 1 de esforços das terças do grupo 1 

 

Fonte: (o autor) 

Figura 117: Diagrama 2 de esforços das terças do grupo 1 

 

Fonte: (o autor) 
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As terças do grupo 2 estão tracionadas em 0,044 KN, sofrendo torção de -0,0658 

KN, momento fletor de 1,81KN.m, cisalhamento de 1,35 KN e deflexão de 0,00012 

m. As Figuras 118 e 119 ilustram os diagramas. 

Figura 118: Diagrama 1 de esforços das terças do grupo 2 

 

Fonte: (o autor) 

Figura 119: Diagrama 2 de esforços das terças do grupo 2 

 

Fonte: (o autor) 
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As terças do grupo 3 estão tracionadas em 1,34 x 10-3 KN, sofrendo torção de -

0,0658 KN, momento fletor de 2,01KN.m, cisalhamento de 1,42 KN e deflexão de 

0,00013m. Os diagramas estão ilustrados nas Figuras 120 e 121. 

Figura 120: Diagrama 1 de esforços das terças do grupo 3 

 

Fonte: (o autor) 

Figura 121: Diagrama 2 de esforços das terças do grupo 3 

 

Fonte: (o autor) 
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As terças do grupo 4 estão comprimidas em 0,028 KN, sofrendo torção de -0,0658 

KN, momento fletor de 1,87KN.m, cisalhamento de 1,37 KN e deflexão de 0,00012m. 

Os diagramas estão apresentados nas Figuras 122 e 123. 

Figura 122: Diagrama 1 de esforços das terças do grupo 4 

 

Fonte: (o autor) 

Figura 123: Diagrama 2 de esforços das terças do grupo 4 

 

Fonte: (o autor) 
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Os diagramas a seguir são das terças do grupo 5, estas sofrem tração de 0,963 KN, 

torção de 0,0658 KN.m, momento fletor de 1,12KN.m, cisalhamento de -1,12 KN e 

deflexão de 0,00011 m. Os diagramas são mostrados nas Figuras 124 e 125. 

Figura 124: Diagrama 1 de esforços das terças do grupo 5 

 

Fonte: (o autor) 

Figura 125: Diagrama 2 de esforços das terças do grupo 5 

 

Fonte: (o autor) 
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Os próximos diagramas, Figuras 126 e 127, pertencem às terças do grupo 6, que 

sofrem tração de 0,068 KN, torção de 0,0658 KN.m, momento fletor de 1,12 KN.m, 

cisalhamento de -1,12 KN e deflexão de 0,00011 m. 

Figura 126: Diagrama 1 de esforços das terças do grupo 6 

 

Fonte: (o autor) 

Figura 127: Diagrama 2 de esforços das terças do grupo 6 

 

Fonte: (o autor) 
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Os diagramas a seguir, Figuras 128 e 129, são das terças do grupo 7, que sofrem 

tração de 0,002 KN, torção de -0,0658 KN.m, momento fletor de 1,12 KN.m, 

cisalhamento de -1,12 KN e deflexão de 0,00011 m. 

Figura 128: Diagrama 1 de esforços das terças do grupo 7 

 

Fonte: (o autor) 

Figura 129: Diagrama 2 de esforços das terças do grupo 7 

 

Fonte: (o autor) 
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Os próximos diagramas, Figura 130 e 131, pertencem às terças do grupo 8, que 

sofrem compressão de 0,043 KN, torção de 0,0658 KN.m, momento fletor de 1,12 

KN.m, cisalhamento de -1,12 KN e deflexão de 0,00011 m. 

Figura 130: Diagrama 1 de esforços das terças do grupo 8 

 

Fonte: (o autor) 

Figura 131: Diagrama 2 de esforços das terças do grupo 8 

 

Fonte: (o autor) 
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Já os diagramas a seguir, Figuras 132 e 133, são das terças do grupo 9, que sofrem 

compressão de 0,308 KN, torção de -0,0658 KN.m, momento fletor de 1,31 KN.m, 

cisalhamento de 1,18 KN e deflexão de 0,00011 m. 

Figura 132: Diagrama 1 de esforços das terças do grupo 9 

 

Fonte: (o autor) 

Figura 133: Diagrama 2 de esforços das terças do grupo 9 

 

Fonte: (o autor) 
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Por fim, os diagramas a seguir, Figura 134 e 135, pertencem às terças do grupo 10, 

que sofrem compressão de 0,601 KN, torção de 0,0658 KN.m, momento fletor de 

1,12 KN.m, cisalhamento de -1,12 KN e deflexão de 0,00011 m. 

Figura 134: Diagrama 1 de esforços das terças do grupo 10 

 

Fonte: (o autor) 

Figura 135: Diagrama 2 de esforços das terças do grupo 10 

 

Fonte: (o autor) 

Nota-se que todas as terças sofrem o mesmo esforço de torção, enquanto as terças 

do grupo 5 são as que estão mais tracionadas. 
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6. CONCLUSÃO 

O presente trabalho se mostrou de grande importância para alunos e engenheiros 

que buscam por bibliografia em português para auxiliar o uso do SAP 2000 pois 

destaca a importância de ter os conhecimentos básicos de cálculo estrutural e do 

funcionamento do programa para que sejam evitados resultados equivocados. 

O SAP 2000 v.16 pode ser uma ferramenta valiosa para auxiliar projetos de 

engenharia de forma confiável e segura. Proporciona resultados detalhados de cada 

barra estudada, além de realizar o dimensionamento estrutural dos elementos a 

partir dos dados inseridos corretamente, apresentando a análise de cada elemento 

para que o usuário defina se a escolha do perfil é coerente.  

No entanto, é primordial ter os conhecimentos básicos de engenharia para ler os 

resultados gerados pelo programa e analisar a coerência e adequação de cada um. 

Neste trabalho, inicialmente fez-se cálculos analíticos para verificar a estabilidade 

dos perfis escolhidos, nessa etapa, foi necessário fazer alterações de perfis que não 

correspondiam à estabilidade requerida, além de mudanças na geometria da 

estrutura para evitar flambagem dos perfis pré-dimensionados pelo programa. 

Somente após verificar a estabilidade dos perfis, é possível inseri-los no SAP 2000 

para que sejam analisados. 

Além disto, é preciso conhecer o funcionamento do software e o modo correto de 

inserção dos dados, para que seja feita a análise correta das cargas incidentes em 

cada barra, caso contrário, os resultados gerados não serão a representação 

fidedigna da realidade da estrutura, levando a conclusões precipitadas dos dados 

apresentados. 

Inserir perfis sem as adequadas verificações prévias, é negligenciar a segurança da 

estrutura, por isto, o programa deve ser manuseado por profissionais com os 

devidos conhecimentos da área e do funcionamento do programa. Este software, 

assim como os demais programas de análise estrutural e/ou dimensionamento, são 

ferramentas importantes, no entanto, precisam ser executados por pessoas 

capacitadas para tal, pois trata-se de estruturas que servirão de abrigo para cargas, 

pessoas e materiais, logo, a segurança é prioritária para o projeto. 
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6.1 SUGESTÕES PARA TRABALHOS FUTUROS 

Sugere-se para o desenvolvimento de futuros trabalho: 

• Comparar os resultados dos cálculos analíticos com os resultados oferecidos 

pelo SAP 2000; 

• Otimizar os resultados ofertados pelo software; 

• Analisar estruturas de galpões mais complexos, com estruturas treliçadas, por 

exemplo; 

• Comparar, economicamente, os resultados ofertados pelo SAP 2000 e outro 

software de dimensionamento; 

• Realizar o dimensionamento de uma estrutural completamente pelo programa 

e fazer a análise dos perfis selecionados quanto a flambagem. 
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ANEXO A – TABELAS DE PERFIL E TELHA 

Tabela A 1: Perfil I Gerdau 

 

Fonte: (Gerdau) 
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Tabela A 2: Perfil U Gerdau 

 

Fonte: (Gerdau) 
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Tabela A 3: Informativo técnico telhas 

 

Fonte: (Regional Telhas) 
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ANEXO B – TABELA DE AÇO 

Tabela B 1: Aço 

 

Fonte: (Associação Brasileira de Normas Técnicas NBR 8800:2008, p. 109) 


